
 

 

 

 

 

 

 

 

 

 

Developer Fast Start 
 

PegaRULES Process Commander V5.5 
 

 

 

 

 

 

 

 

 

 

 



 

 

 Copyright 2009 
Pegasystems Inc., Cambridge, MA 

All rights reserved. 

This document describes products and services of Pegasystems Inc. It may contain trade secrets and 
proprietary information. The document and product are protected by copyright and distributed under licenses 
restricting their use, copying, distribution, or transmittal in any form without prior written authorization of 
Pegasystems Inc.  

This document is current as of the date of publication only. Changes in the document may be made from time 
to time at the discretion by Pegasystems. This document remains the property of Pegasystems and must be 
returned to it upon request. This document does not imply any commitment to offer or deliver the products or 
services described.  

This document may include references to Pegasystems product features that have not been licensed by your 
company. If you have questions about whether a particular capability is included in your installation, please 
consult your Pegasystems service consultant.  

For Pegasystems trademarks and registered trademarks, all rights reserved. Other brand or product names 
are trademarks of their respective holders. 

Although Pegasystems Inc. strives for accuracy in its publications, any publication may contain inaccuracies 
or typographical errors.  This document or Help System could contain technical inaccuracies or typographical 
errors. Changes are periodically added to the information herein. Pegasystems Inc. may make improvements 
and/or changes in the information described herein at any time. 
 
 
 
 
 
This document is the property of: 
Pegasystems Inc. 
101 Main Street 
Cambridge, MA  02142-1590 
 
Phone: (617) 374-9600 
Fax: (617) 374-9620 
www.pega.com 
 
Document: Developer Fast Start v5.5 
 
PegaRULES Process Commander v5.5 
 
Updated: June 22, 2009 
 



 

 

Contents 
 

Chapter 1:  Overview ................................................................................................................... 1-1 

Business Process Management .......................................................................................... 1-3 

Structure of This Document ................................................................................................ 1-4 

Support Knowledgebase ..................................................................................................... 1-5 

Prerequisites ......................................................................................................................... 1-6 

Chapter 2:  Using the Application .............................................................................................. 2-1 

Creating a Purchase Order .................................................................................................. 2-2 
Adding Items to Your Purchase Order ........................................................................ 2-6 

Approving the Purchase Order Request .......................................................................... 2-11 

Chapter 3:  Improving the Application ....................................................................................... 3-1 

Changing the Purchase Order Request Process ............................................................... 3-3 
Defining a New Decision Table Rule .......................................................................... 3-14 
Editing the Flow ........................................................................................................... 3-19 

Chapter 4:  Updating the User Interface .................................................................................... 4-1 

Building a New Flow Action rule ......................................................................................... 4-2 

Editing the Flow .................................................................................................................. 4-11 

Adding a Data Field ............................................................................................................ 4-14 

Inspecting Declarative Rules ............................................................................................. 4-20 
Using the Declarative Rules Inspector ...................................................................... 4-21 

Chapter 5:  Reviewing Your Application.................................................................................. 5-23 

Developing Applications by Changing Rules .................................................................. 5-23 

Technology Under the Covers .......................................................................................... 5-25 

Chapter 6:  Documenting Your Application ............................................................................ 6-26 

Documenting the Order Entry System Application ......................................................... 6-27 

Description .......................................................................................................................... 6-33 

Actors .................................................................................................................................. 6-33 

Work Types ......................................................................................................................... 6-33 

RuleSets .............................................................................................................................. 6-33 

PurchaseOrder - Flow ........................................................................................................ 6-35 
Primary Path ................................................................................................................ 6-36 
Alternate Path 1 .............................................................................................................. 37 



ii   Contents 

 

Alternate Path 2 .............................................................................................................. 38 
Alternate Path 3 .............................................................................................................. 38 
Alternate Path 4 .............................................................................................................. 38 
Other Referenced Rules ................................................................................................ 38 

PurchaseOrder - Flow ........................................................................................................... 39 
Primary Path ................................................................................................................... 39 
Alternate Path 1 .............................................................................................................. 40 
Alternate Path 2 .............................................................................................................. 40 
Alternate Path 3 .............................................................................................................. 40 

Tables ..................................................................................................................................... 41 
PriceLookup .................................................................................................................... 41 
NeedsVPApproval .......................................................................................................... 41 

Trees ....................................................................................................................................... 42 
OrderTotalNeedsApproval ............................................................................................. 42 

Map Values ............................................................................................................................. 42 

Expressions ........................................................................................................................... 46 

Triggers .................................................................................................................................. 46 

OnChange .............................................................................................................................. 46 

Appendix A:  The Developer Toolbar .......................................................................................... 47 

Toolbar Buttons and Functions ........................................................................................... 47 

Appendix B:  Workstation Setup ................................................................................................... 1 

Internet Explorer Settings ....................................................................................................... 2 
Temporary Internet Files Settings .................................................................................. 2 
Downloaded Program Files ............................................................................................. 2 
Other Security Settings ................................................................................................... 3 

Performance Tips and Keyboard Shortcuts .......................................................................... 4 

Visio Settings ........................................................................................................................... 5 

 

 

 

 

 



 

 

Chapter 1:   
Overview   

Welcome to the Developer Fast Start. This book introduces PegaRULES 
Process Commander and provides hands-on instructions for modifying an 
application built on PegaRULES Process Commander. It also introduces terms 
and skills for application developers. (For brevity, the product is hereafter called 
Process Commander.) 

The hands-on tasks involve working with a small application called the Order 
Entry System. The application allows employees of AlphaCorp to submit 
purchase order requests using their Web browser and it automates the process 
of entering, routing, and approving purchase orders.  
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The Order Entry System application is intentionally incomplete and simplified. 
Your assignment is to make changes and enhancements to it. The tasks 
presented in this book show you how to extend the application by adding and 
modifying rules to meet the needs of AlphaCorp. By following these exercises, 
you will learn to: 

■ Navigate within the Developer portal 

■ Change the rules to reflect new steps in a business process  

■ Create rules that enhance the application user interface and behavior 

■ Produce a Microsoft Word document that describes the application and lists 
its files, functions, and features. 

You make the modifications on your Process Commander system in a RuleSet 
designated for your development. This book takes you step-by-step through each 
modification. 
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Business Process Management 
According to the Business Process Management Group (at www.bpmg.org), 
Business Process Management (BPM) is the organizational activity "that 
incorporates: Planning, Designing, Building, Operating, Maintaining, and 
Improving the business processes and their enabling capabilities forever and for 
everyone. Business processes are capabilities, as important as facilities, people, 
and technology. Like all assets they must be managed from inception to 
retirement.” 

Process Commander supports Simply Smart Business Process Management 
through rules covering flows, assignments, routing, decisions, and automated 
processing. Process Commander applications provide process management and 
automation through six functional capabilities, informally known as the Six R's: 

■ Receiving — Accepting and capturing the essential data describing work 
from multiple sources, including keyboards, scanners, and external systems, 
in a wide range of media and formats. 

■ Routing — Using characteristics of the work together with knowledge about 
the workforce to make intelligent matches and assignments. 

■ Reporting — Providing real-time visibility of work in progress, work 
completed, productivity, bottlenecks, and quality. 

■ Responding — Communicating status, requests for information, and 
progress to the work originator and to other people involved in the work, by 
e-mail, fax, written mail, and other means. 

■ Researching — Accessing external systems and databases through 
connectors to support analysis and decision-making. 

■ Resolving — Completing the work and updating downstream systems 
promptly through automated processing and automated support of users, 

Process Commander is the only BPM solution that automates both the business 
rules and the business processes that drive work to completion. 

Additionally, Process Commander employs a sophisticated common object 
model to deliver the power of process and practice integration. This integration is 
achieved without the expense and resources associated with maintaining 
separate business process and rules databases, user interfaces, test 
environments, and production environments. 

http://www.bpmg.org/�
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Structure of This Document 
This book includes the following chapters and appendices: 

■ Chapter 2 describes how to use Order Entry System application. 

■ Chapter 3 describes how to improve the application by changing the 
purchase order request process.  

■ Chapter 4 describes how to update the user interface. 

■ Chapter 5 reviews all tasks you completed in the previous chapters.  

■ Chapter 6 describes how to document your application using Process 
Commander. 

■ Appendix A provides a description of the icons and buttons found on the 
Process Commander toolbar.  

■ Appendix B provides additional information that might be useful when setting 
up your workstation.  

Tip:  Print Appendix A and have it available to help you learn about the 
toolbar buttons.  
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Support Knowledgebase 
The Pega Developer Network (PDN), located at http://pdn.pega.com, is the 
primary technical resource area for the PegaRULES Process Commander 
developer community. The PDN contains a broad range of technical articles 
including troubleshooting and “how-to” information as well as a comprehensive 
and searchable knowledgebase to help speed application development.  

The PDN also links directly to the customer support section of the Pegasystems 
website located at http://pdn.pega.com/ProductSupport/ProductSupport.asp 
where customers and partners submit support and product enhancement 
requests. 

http://pdn.pega.com/�
http://www.pega.com/�
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Prerequisites 
To follow the steps in this book, verify the following: 

■ Process Commander Version 5.5 is installed and all error conditions are 
resolved. This specific software version is required to accommodate the 
Order Entry System application that you will use in this Developer Fast Start 
tutorial.  

■ The installed Process Commander RuleSet versions are not lower than those 
listed below:  

Pega-IntSvcs:05-05 

Pega-ProCom:05-05 

Pega-Rules:05-05 

Pega-WB:05-05 

■ A Windows VISTA or Windows XP workstation with Microsoft Visio 2002, 
2003 or 2007 (any edition) is installed. 

■ Microsoft Word 2002 or later is installed. 

■ Microsoft Internet Explorer (IE) version 6.01 or version 7 with current 
Microsoft security patches is installed. All pop-up blockers (such as those 
provided by Yahoo! or Google toolbars) must be disabled.  

Appendix B also describes Internet Explorer and Microsoft Visio settings 
appropriate for Process Commander developers. 

 



 

 

Chapter 2:   
Using the Application  

This chapter shows you how to use the application to experience it from the 
worker and manager points of view by: 

■ Creating a purchase order request  

■ Approving the purchase order request  

In Chapters 3 and 4, you assume the role of developer and change the business 
process, appearance, and functions supported by the application. 
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Creating a Purchase Order 
1. Log in as WorkUser@AlphaCorp.com with the password rules to access 

the Order Entry System application. The Work User portal appears (Figure 
2-1). 

 
Figure 2-1. User Portal 

If prompted with a Windows Security warning, click Install (Figure 2-2). This 
may occur a few more times as Windows downloads each needed ActiveX 
control. 

 
Figure 2-2. Windows Security Warning 

Figure 2-1 shows the portal layout typical for application users who are not 
managers. It provides access to work, status information, and facilities for 
searching through both incomplete and completed work. The colors, fonts, 
and logo used in this layout are Process Commander defaults; you can build 
applications using your company’s standards and formats. 

The area to the right labeled My Work in Progress shows any purchase 
orders you previously entered that are not completely processed. In the 

mailto:WorkUser@AlphaCorp.com�
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above example, this area, known as your worklist, is empty. Each user’s 
worklist contains a prioritized list of work items. 

Note: You can exit from the application at any time by clicking the Log 
Off link at the upper right of this window. Do this before closing the 
window.  
Do not use the Internet Explorer Back button when using Process 
Commander. Instead, use the Back button at the upper right corner of the 
window ( ) when it is enabled. 

2. Select Purchase Order from the New selection box (Figure 2-3).  

 
Figure 2-3. New Selection Box — Purchase Order 

3. On the New Purchase Order form, select IT from the Department Name 
selection box. Enter a Department Number consisting only of numeric digits 
(Figure 2-4).  

 
Figure 2-4. New Order Entry Form 
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4. Click Create (located at the bottom of the form) to transmit your input to the 
Process Commander server. The application creates a purchase order 
request (also known as a work object or work item) and assigns a 
sequential identifier to it known as the work object ID, visible in the top bar 
(Figure 2-5). In this application, the work object IDs begin with the prefix 
“PO” to identify purchase orders.  

 
Figure 2-5. Purchase Order Request PO-1 

5. Click the  (close) icon in the upper right corner of the form to close the 
work object. An assignment row for this work object appears on your 
worklist because additional steps are needed. Figure 2-6 shows a worklist 
containing one assignment row, for the purchase order.  



Developer Fast Start  2-5 

 

 

 
Figure 2-6. Purchase Order in the Worklist 
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Adding Items to Your Purchase Order 
1. On your worklist, locate the purchase order you created. Click the ID to 

reopen the purchase order form for additional processing. 

2. Select an item from the item selection box and enter the quantity to be 
purchased. Click the Add a Row icon  to add rows and enter additional 
items (Figure 2-7). The application displays the item price for each item and 
calculates a line item total price (price multiplied by quantity). Select at 
least one item and enter a quantity. If you want you can enter several rows. 
Figure 2-7 shows an example.  

 
Figure 2-7. Line Items 

Note:  If you make a mistake and want to delete an item, click the 
garbage can ( ) to the right of the row.  

3. Click Submit to move to the next step in the purchase order process (use 
the right-hand scroll bar to display the Submit button if necessary). 

4. The Confirm this order form appears (Figure 2-8). 
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Figure 2-8. Purchase Order with Add Shipping Details 

5. Click the Where-Am-I icon  to see the location of this purchase order in 
the process flow, and the path that this work object has followed so far 
(Figure 2-9). The check marks indicate steps that are complete; the arrow 
marks the current step. The shapes in this diagram are types of building 
blocks in the Process Commander representation of the business process. 
Common shapes are explained in Chapter 3.  
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Figure 2-9. Location of Request in Process Flow 

The second assignment or user action in the Purchase Order process flow 
corresponds to the rectangle labeled Confirm in the flow diagram. This 
assignment allows users to confirm the order and add shipping details to a 
purchase order request. 

6. Close the You Are Here window. 

7. Select the “Add Shipping Details” check box. The Shipping Information 
section appears (Figure 2-10).  
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Figure 2-10. Shipping Details 

8. Enter the shipping information for your purchase order.  

Note: Do not press the Enter key to advance from field to field, as 
this submits the form. 

9. Change Multiple Deliveries from 0 to 2. Select a Delivery Method for each 
of the deliveries and click Submit (Figure 2-11). 

 
Figure 2-11. Multiple Delivery Selection 
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10. The purchase order request automatically routes to a manager for approval 
and is placed on the manager’s worklist. Manager approval is required 
when the order total is greater than $100. (You can test this by creating a 
second purchase order request with a total of $100 or less.) 



Developer Fast Start  2-11 

 

 

Approving the Purchase Order Request 
Managers or supervisors have access to all the facilities available to application 
users and more. In this sample application, managers have the ability to approve 
or reject certain purchase orders.  

1. Log in as WorkManager@AlphaCorp.com with the password rules to 
access the WorkManager portal (Figure 2-12). 

 
Figure 2-12. WorkManager Portal 

Managers use different facilities than their staff. As you are acting as a 
manager, you may be prompted with a Windows warning regarding one or a 
few additional ActiveX controls. Click Install each time. Figure 2-13 shows an 
example.  

 
Figure 2-13. ActiveX Control Warning 

mailto:WorkManager@AlphaCorp.com�
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2. Click the Process Work bar (bottom left) to change the work space on the 
right. The manager’s worklist appears.  

3. Hover the mouse pointer over a row in the worklist to see Smart Info details 
for that purchase order (Figure 2-14). Find the one you entered most 
recently as the WorkUser. 

 
Figure 2-14. Worklist Item and Pop-Up Details 

4. Click the work object ID to open the purchase order form.  

5. Click Approve to approve the purchase order request (Figure 2-15).  

 
Figure 2-15. Take Action Form 
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Note: After a manager Approves (or Rejects) the purchase order request, 
the work object becomes resolved with a status of Resolved-Completed, 
or Resolved-Rejected, and the Order Entry application displays a 
confirmation form (Figure 2-16). The resolved status indicates that the 
business process is complete. 

 
Figure 2-16. Work Object Confirmation 

Other facilities on the WorkManager portal allow managers or supervisors to 
review worklists of staff, transfer work among staff, and review real-time 
reports about progress, volume, backlogs, and trends. 

6. Click Log Off in the upper right-hand corner of your screen.





 

 

Chapter 3:   
Improving the Application  

In this chapter, you will extend the purchase order process to require a second 
approval to some purchase orders. To make the application more closely match 
AlphaCorp business practices, you will modify the process flow to require a Vice 
President’s (VP) approval for those purchase order requests that meet all the 
criteria in a row of the following table (Figure 3-1). At least one row must match 
the criteria for the purchase order to go to the VP for approval 

Dept Name Bill Customer Order Total 
IT  >$1,000 
HR  >$500 
Finance No  
Finance Yes >$200 
Legal Yes >$500 
Legal No >$200 
IT No >$2,000 

Figure 3-1. Purchase Order Criteria 

Example:  If the Department Name is Finance and the Bill Customer check box is 
cleared (not checked), the third row of this table indicates that the VP approval is 
required for this request. If the Department Name is Finance, the Bill Customer 
check box is checked, and the Order Total is $199.00, then none of the rows 
contain criteria that are all met, and therefore no VP approval is required. 
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When you complete the changes, the revised process diagram will look like 
Figure 3-2, with three added shapes contained within the dashed red lines. 

 
Figure 3-2. Revised Process Flow Diagram  
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Changing the Purchase Order Request Process 
Follow these steps to learn about the Process Commander Developer portal.  

1. Log in as Developer@AlphaCorp.com with the password rules The 
Developer portal appears (Figure 3-3).  

Note: If this application is being accessed by multiple users, you may need 
to log in as Developer1@AlphaCorp.com, Developer2, and so on. 

 
Figure 3-3. Developer Portal 

2. The Application Explorer (App Explorer tab) in the left panel provides quick 
access to the rules in this application. It presents a three-level tree 
structure. Rules are organized into Process Commander rule categories. 
For example, the Order Entry System contains the Purchase Order class 
which contains rules belonging to various rule type categories such as 
Property, Decision, and Process.

mailto:DeveloperNN@AlphaCorp.com�
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Open the PurchaseOrder flow rule, following the steps below (Figure 3-4). 

a.   Click + to expand the PurchaseOrder class  and see the categories it 
contains. 

b.   Click the + to expand the Process category  to see the rule types it 
contains. 

c.   Click the + to expand the Flow rule type   

d.   Click the PurchaseOrder link to open the flow rule. (Each blue dot 
identifies a single rule.) 

 
Figure 3-4. Application Explorer 

Note:  If Windows presents an additional ActiveX warning, click Install to 
accept.  
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Figure 3-5. Flow Rule and Save As Toolbar Button 

The Flow rule form for the PurchaseOrder process appears (Figure 3-5). 
Process Commander has dozens of rule types; each type is identified in the 
upper left of a corresponding form (FLOW in this case).  

Tabs allow access to individual fields on the form, and tools on the toolbar 
operate on the rule. The PurchaseOrder flow rule is marked read-only ( ), 
so you can’t alter it directly. Instead, you will save a copy of that flow rule into 
your developer RuleSet named OrderEntryDev, and update your copy. 

Note:  If you have signed on as Developer1, Developer2, Developer3, and so 
on, your RuleSets will be OrderEntryDev1, OrderEntryDev2, OrderEntryDev3, 
and so on.  
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3. Click Save As  to save a copy of the process flow rule into your own 
RuleSet. A Save As Rule Instance dialog appears (Figure 3-6).  

 
Figure 3-6. Save Rule Instance Dialog 

The two fields labeled Applies To and Flow Type identify the keys of the flow 
rule. Do not alter the values in these fields; the new flow rule should use the 
same name as the original you are copying.  

Select OrderEntryDev (or OrderEntryDev1, OrderEntryDev2, 
OrderEntryDev3, and so on) from the RuleSet Name drop-down list. The 
Version field defaults to 01-01-01. 

4. Click the Save As button.  

5. The next steps change the Purchase Order flow to include a decision 
shape that determines whether the VP must approve a purchase order 
request. A decision shape, represented in the flow diagram by an orange 
diamond, identifies an automatic step where processing may advance 
along any one of two or more outcomes. In this case, the decision shape 
has two outcomes: VP approval is required (True), and VP approval is not 
required (False). 
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Click the Flow Editor toolbar icon ( ) as shown in Figure 3-7. This opens 
the Visio Flow Editor. 

 
Figure 3-7. Purchase Order Flow Rule 

Note:  When the Visio Flow Editor opens, it may display a security 
warning (Figure 3-8). If it does, select “Always trust macros from this 
publisher” and then click Enable Macros. If the Enable Macros button 
remains disabled, your Visio security settings are set too high. In that 
case, close the dialog box. Update Visio as described in Appendix B and 
try again.  
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Figure 3-8. Visio Macro Warning 

When Visio opens, it displays the flow diagram as shown in Figure 3-9. 

 
Figure 3-9. Visio Flow Diagram 
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The blue rectangle at the top of the flow diagram identifies the start of the 
business process where a new purchase order request is created. 
Processing of each purchase order proceeds along the connectors from 
shape to shape. The three green rectangles mark assignment shapes 
(ItemEntry, Confirm, and ManagerApproval) — the steps in the process that 
require a user or manager to enter information or record their decisions The 
orange diamond shape labeled NeedsApproval identifies an automated 
decision, in this case with two outcomes: True or False.  

The Visio tool also contains a Visio Shapes panel, presenting the 18 Process 
Flow shapes that Process Commander uses (Figure 3-10). Each has a 
descriptive ToolTip. (If the names under the icons do not display, right click 
on the Process Flow heading and select View > Icons and Names). 

 
Figure 3-10. Process Flow Shapes 

Note: While using Visio, you can click the Undo button ( ) on the toolbar 
to reverse the most recent action. Do not attempt to log off while Visio is 
active.  
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6. Add a Decision shape to the process flow below the existing 
ManagerApproval assignment shape as follows: 

a.   Click and drag a Decision shape  from the Shapes stencil onto the 
flow diagram.  

b.   Position the Decision shape below the ManagerApproval assignment 
shape (Figure 3-11). 

 
Figure 3-11. Position of Decision Shape  

7. Click on the Decision shape to select it and complete the Decision 
Properties panel that appears to the left of the process flow diagram 
(Figure 3-12): 

a.   Select Decision Table as the Type. 

b.   Enter NeedsVPApproval (with no spaces) in the Rule field. The orange 
asterisk identifies required fields. 

c.   The Name field is arbitrary and may contain spaces. Accept the default 
value (which Process Commander copies from the Rule field) by doing 
nothing or enter other brief text to identify this task. 
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Figure 3-12. Decision Properties  

At this point, the flow rule references a decision table rule, but one that does 
not yet exist.  
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8. Click the Open icon ( ) next to the NeedsVPApproval Rule field to create 
a new decision table rule with that name. A New Rule Instance dialog 
appears (Figure 3-13). 

 
Figure 3-13. New Rule Instance 

9. Confirm or enter the following: 

– Do not change the Applies To field.  

– The Purpose should be NeedsVPApproval, if not change it 

– The RuleSet should be OrderEntryDev (or OrderEntryDev1, 
OrderEntryDev 2, OrderEntryDev3, and so on), if not change it 

– The Version should be to 01-01-01, if not change it 

10. Click Create. The Decision Table rule form appears (Figure 3-14). 
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Figure 3-14. Decision Table Rule Form 
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Defining a New Decision Table Rule 
1. Click the Results tab to bring it to the front. Complete two rows of the 

Allowed Results array to identify the allowed results for this decision table  
(Figure 3-15). In this case, the allowed results are: 

– True: this purchase order requires VP approval  

– False: this purchase order does not require VP approval 

 
Figure 3-15. Results Tab  

When completing arrays, you can click the: 

— to add a row at the bottom 

 — to add a row between other rows 

 — to delete a row 

Note:  No changes are needed to the Set Properties?, Options, and 
Preset Property Values areas of this tab.  

2. Click the Table tab to bring it to the front. In this tab, you record the 
decision table logic presented in Figure 3-1. The decision table in this 
example has three inputs that are identified by property rules: DeptName, 
BillCustomer, and OrderTotal. Each column in the decision table (except 
the Return column) corresponds to a property. Follow the steps below to 
complete the Table tab. 

a.   Click the column heading cell (just below Conditions) to label the column 
in the matrix. A Property Chooser pop-up window displays (Figure 3-16).  
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Figure 3-16. Decision Table Rule – Decision Property Chooser 

Note: The green triangle at the bottom right corner of the Property 
input box is a SmartPrompt control. SmartPrompts appear on many 
rule and data forms to make a selection list available for fast entry. 
To complete a field that contains this control, press the Down Arrow 
key to access the list. This SmartPrompt control displays a list of 
property rules from which you can select.  

b.   Use the SmartPrompt feature to access a list of all the properties 
available. Scroll down until you see the DeptName property and press 
Enter or click the property name to select it (Figure 3-17).  

 
Figure 3-17. Select a Property in the Decision Table Property Chooser  
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c.   The Label field contains a default value. Click Save to save the property 
to the decision table matrix. 

3. The starting table contains a single input column. You need to add two 
columns; one for the BillCustomer property and one for the OrderTotal 
property. To add a column to the right of the starting column: 

a.   Click the starting column to select it. 

b.   Click the Insert Column After icon  (Figure 3-18). A new column 
appears to the right of the starting column (Figure 3-19). Do this again to 
add a second column.  

 
Figure 3-18. Decision Table Rule – Adding a Column (before) 

 
Figure 3-19. Decision Table Rule – Adding a Column (after) 

4. Add the Bill Customer and Order Total properties (Figure 3-20) to the 
columns using the Property Chooser (Figure 3-17).  

 
Figure 3-20. Decision Table Rule – Labeling a Column  
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5. Enter the first decision criteria as shown in Figure 3-1 to complete the first 
row of your decision table, following the steps below.  

a.   In DeptName, click on the field and use the SmartPrompt to select the 
name IT.  

b.   Leave the BillCustomer property blank.  

c.   Enter >1000 for OrderTotal. You can omit the dollar sign, commas, and 
pennies in the amount.  

d.   In the Return column, select True for the Return value (Figure 3-21). 
There are only two allowed return actions, True and False, which are 
defined by the results that you specified earlier on the Results tab. 

 
Figure 3-21. Decision Table Rule – First Row Completed  

6. Enter additional rows by clicking the Insert Row After icon  (Figure 3-22). 

 
Figure 3-22. Decision Table Rule – Empty Rows Added 
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7. Using Figure 3-1 as your guide, complete the Table so it looks like Figure 
3-23. Enter =False for No and =True for Yes. 

 

 
Figure 3-23. Decision Table Rule Completed  

8. Click Save to save the updated decision table rule. An icon at the top of 
the form indicates that the rule was saved, but with a warning.  

9. Scroll down to read the warning message below the form. Click the Show 
Conflicts button to check this rule for logic consistency (Figure 3-24). One 
logic error appears in the bottom row (indicated by a warning icon ). The 
bottom row contains an unreachable condition as there is a combination of 
input values that cannot be used; the top row masks the bottom row. 

 
Figure 3-24. Decision Table Rule – Logic Errors  

10. To delete a row, click in any cell in the row to select the row, then select the 
Delete Row icon . Click the Show Conflicts button again to confirm that 
no logic errors remain. A message displays “The Decision table is 
consistent.”  
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11. Save the revised decision table and close the form. You are returned to the 
Visio Flow Editor. 

Editing the Flow 
1. In Visio Flow Editor, click the Apply button in the Decision Properties panel 

to apply the properties to the Decision shape. Process Commander 
automatically presents the True and False return values as connectors 
from the decision shape (Figure 3-25). 

 
Figure 3-25. Visio Updates 

2. Now you will redirect the flow action (connector) from the ManagerApproval 
Assignment shape to the NeedsVPApproval Decision shape, following the 
steps below: 

a.   Click the ManagerResolve connector that starts at the ManagerApproval 
assignment shape and ends at the UpdateStatusCompleted Utility  
shape.  

b.   Click the red square connected to the ManagerApproval assignment 
shape and drag the tail end to the blue X in the center of the shape.  

c.   Click the red square connected to the UpdateStatusCompleted Utility 
shape and drag the arrow head of the connector to the top of the 
NeedsVPApproval decision shape (Figure 3-26). If the ManagerResolve 
label does not appear, pull the decision shape down to reveal it. 

 
Figure 3-26. Visio Updates 

This connection means that the business process requires a decision after a 
purchase order request is approved by the manager.  
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3. Select and drag an Assignment shape  from the Shapes stencil and 
drop it below the Decision shape, so that purchase order requests can be 
routed to the Vice President. Position the new VPApproval assignment 
shape below the NeedsVPApproval decision shape (Figure 3-27). 

 
Figure 3-27. Assignment Shape 

4. While the Assignment shape is selected, complete the Assignment 
Properties panel as shown in Figure 3-28. In the Harness field, use 
SmartPrompt to select Perform_Buttons. (A Process Commander harness 
rule provides the basis of a form for work object processing. This rule name 
contains an underscore character, not a dash or minus sign.) 

 
Figure 3-28. Assignment Properties  
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5. In the StatusWork field, use the SmartPrompt to select Pending-Approval. 
Type text into the Name, Instructions and Confirmation fields. Then click 
Apply to apply these inputs to the Assignment shape.  

6. Add a Router shape to the VPApproval Assignment shape so that the 
Purchase Order is routed to the user identified by the Operator ID 
VP@AlphaCorp.com (Figure 3-29) as follows:  

a.   Select and drag a Router shape  from the Shapes stencil onto the 
flow diagram.  

b.   Connect the Router shape to the VPApproval Assignment shape. 

 
Figure 3-29. Router Shape  

7. Select the Router shape. Complete the Router Properties panel as shown 
in Figure 3-30 and then click Apply. 

 
Figure 3-30. Router Properties  

Note: The blue triangle at the bottom right corner of the Rule field input 
box is a SmartPrompt control. Press the Down Arrow key to access the 
list. This SmartPrompt displays a list of router rule names from which you 
can select. 

8. The True and False connectors from the Decision shape are currently 
“dangling” or unattached to other shapes (Figure 3-29). Process 
Commander uses red connectors to indicate that they are not attached to a 
shape. Follow the steps below to attach the connectors.  

a.   Attach the True connector to the VPApproval Assignment shape to send 
the purchase order request to the Vice President for approval when the 
decision table calculates a return value of True.  

mailto:VP@AlphaCorp.com�
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b.   Attach the False connector to the UpdateStatusCompleted Utility shape 
 .  

When the decision table rule returns a value of False, the Vice President’s 
approval is not required. The following events occur automatically: 

– The request’s status is updated to “Resolved-Completed.” 

– A Confirmation Note is set to Resolved. 

– The purchase order request is resolved.  

Figure 3-31 shows all the shapes connected correctly.  

 
Figure 3-31. True / False Connector  

9. Add connectors from the VPApproval Assignment shape following the steps 
below:  

a.   Click and drag the Connector shape  in the Shapes stencil and drag it 
anywhere on the flow diagram.  

b.   Repeat to add a second connector.  

c.   Attach the tail ends to the bottom of the VPApproval Assignment shape. 

d.   Connect one connector head to the UpdateStatusCompleted Utility 
shape. 

e.   Connect the second connector head to the UpdateStatusReject Utility 
shape (Figure 3-32). 

 
Figure 3-32. Connectors from Assignment Shapes  
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10. Define the Connector properties for the connector that ends with the 
UpdateStatusCompleted utility shape. Select ManagerResolve as the flow 
action (Figure 3-33). Enter 75 as the Likelihood value. Click Apply.  

 
Figure 3-33. Manager Resolve  

11. Complete the Connector Properties panel for the connector that leads to 
the UpdateStatusReject Utility shape. Select Reject as the Flow Action and 
enter 25 as the Likelihood (Figure 3-34). Click Apply. 

 
Figure 3-34. Reject Connector  

12. Click anywhere in white space in the Visio work area; confirm that none of 
the connector arrows are red, including the small boxes at the arrow head 
and arrow tail. Process Commander marks incomplete connectors in red 
and “floating” connectors (those with both head and tail unconnected) in 
gray. Drag the connector arrows to connect them to the shapes if 
necessary. Your diagram should look like Figure 3-2. 

13. Save  your flow changes. If errors appear, fix any errors to correct the 
diagram and re-save. Exit the Flow Editor and return to the Flow form by 
clicking Return . 
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14. Test your process changes using the Run menu. Select Run > Process > 
Purchase Order and create a new purchase order request (Figure 3-35). 
You do not need to log out, but can act as the entry user, manager, and 
VP. 

 
Figure 3-35. Run Menu 

To complete the test, do the following: 

a.   Create a new purchase order request, using data values similar to those 
entered in the example in Chapter 2.  

b.   Enter line items and quantities that produce a total amount that meets 
one of the criteria for requiring VP approval shown in Figure 3-1. For 
example, if the Department is HR, any order over $500 requires her 
review.  

c.   Confirm the purchase order request. 

d.   As manager, approve the request. 

e.   Verify that after the manager approves the purchase order request, the 
request is routed to the VP for her approval. 

Of course, more complete testing of every condition in the decision table rule is 
required in real-world development situations.  

You may log off now or continue with the next chapter. To log off, click the Log 
Off link in the upper right area of the portal window. 



 

 

Chapter 4:   
Updating the User Interface  

Currently, the Vice President sees the same user interface as the manager when 
approving or rejecting a purchase order request. However, the VP must enter an 
approval code and optionally a note.  

In this chapter you will enhance the user interface to allow the VP to enter these 
details. 
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Building a New Flow Action rule 
Rules known as flow actions determine which data values are requested in the 
Take Action area of a work object form when a user completes an assignment. 
Rather than create a new flow action rule from scratch, it is easier to create the 
new rule by copying and then modifying the existing ManagerResolve flow action 
rule. 

1. Log in as Developer@AlphaCorp.com with the password rules, as in 
Chapter 3. 

2. From the Application Explorer tree in the left panel, find and click the 
ManagerResolve flow action link to open that rule, following the steps 
below:  

a.   Click the +  element to expand the PurchaseOrder class. 

b.   Click the +  to expand the User Interface category. 

c.   Click +  to expand the Flow Action rule type  

d.   Click the ManagerResolve link (Figure 4-1). The ManagerResolve flow 
action rule appears. 

 
Figure 4-1. ManagerResolve Flow Action Rule 

3. Click Save As ( ) to create a copy of that flow action rule. The Save Rule 
Instance dialog appears (Figure 4-2). Enter the following:  

a.   For the Action Name, replace ManagerResolve with VPResolve. 

b.   For the RuleSet, select OrderEntryDev. 

c.   For the Version, accept the default value 01-01-01. 

mailto:DeveloperNN@AlphaCorp.com�
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Figure 4-2. Save New Instance 

4. Click the Save As button to create the new VPResolve flow action. At this 
point the new VPResolve and the original ManagerResolve flow action 
rules are very similar. 

5. Like the original ManagerResolve flow action rule, the new flow action rule 
presents no display to users. When managers click Approve, the flow 
action executes without presenting any output. Change the newly created 
VPResolve flow action rule to remove the “No HTML” option following the 
steps below.  

a.   Click the HTML tab to bring it to the front.  

b.   On the HTML tab, replace No HTML with Define Form (Figure 4-3). 
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Figure 4-3. HTML for Flow Action Rule 

6. On the Form tab, modify the Layout to allow the vice president to enter an 
approval code and an optional note, following the steps below:  

a.   The Manager Resolve flow action appears as shown in Figure 4-4.  

 
Figure 4-4. Manager Resolve Flow Action 

b.   Select the upper-left Label cell and click the magnifying glass icon ( ). 
This opens a Cell Properties panel. Enter the text label (user prompt) 
Approval Code in the Value field as shown in Figure 4-5. On the 
General tab, click the Required box. This will display a required icon ( ) 
next to the label. Click OK. 
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Figure 4-5. Approval Code Label on Flow Action Form  

c.   From the Basic control group ( ), drag the Input Box item to the 
Field on the top row as shown in Figure 4-6. 
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Figure 4-6. Add the Label Field 

d.   Click the magnifying glass icon ( ) next to the cell. This opens a Cell 
Properties panel as shown in Figure 4-7. 

 
Figure 4-7. Field Cell Properties Panel 
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e.   Overwrite the default name (.pyTemplateInputBox) with the name 
.ApprovalCode (using the exact case and being sure to include a 
leading period). 

f.   Click the Open icon ( ). This opens a Properties New Rule Instance 
dialog as shown in Figure 4-8.  

 
Figure 4-8. New Rule Instance Dialog 

g.   Make sure that OrderEntryDev is selected in the RuleSet Name field. 
Click the Quick Create button to create the new property rule in your 
OrderEntryDev RuleSet. The New Rule Instance closes. 

h.   Return to the Cell Properties panel, select the General tab, and click the 
Required box. This ensures that a value is entered in the work form 
before it is submitted. Otherwise, an error message appears. Click OK.  

i.   Click the Label cell on the second row. Open the Cell Properties Panel 
and enter Note in the Value field. Click OK 

j.   From the Basic control group, drag a Text Area item to the right cell in 
the second row Field as shown in Figure 4-9. 
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Figure 4-9. Add the Text Area Field 

k.   Open the Cell Properties panel. On the Display As field, press the down 
arrow and a list of properties will display using SmartPrompt. Overwrite 
the default value (.pyTemplateTextArea) with the property named 
.pyNote in the Name field and click Apply.  

l.   Select TextAreaWithExpand using SmartPrompt in the Display As field 
as shown in Figure 4-10. 
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Figure 4-10. TextAreaWithExpand Format Option 

m.   Click OK and Save the rule to save your changes to the Flow Action 
form. 

7. Click Preview  to view the runtime presentation of the new flow action 
rule, at the bottom of the window (Figure 4-11). 
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Figure 4-11. UI Preview  

8. Click the X button at the top right of the Preview window to close it. 

9. Click Close  to close the VPResolve flow action form. 
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Editing the Flow  
At this point, the new flow action VPApproval is complete, but not referenced by 
any shape in the flow rule. In this section you will use the Flow Editor again to 
update the PurchaseOrder flow, so that the new VPResolve flow action runs 
when the VP approves a purchase order request. 

1. Open the PurchaseOrder flow using the Application Explorer. 

2. Click the Flow Editor toolbar button . Replace the ManagerResolve flow 
action (a connector) from the VPApproval Assignment shape with the new 
VPResolve flow action, following the steps below:  

a.   Select the ManagerResolve connector that leads from the VPApproval 
Assignment shape (Figure 4-12).  

b.   In the Connector Properties panel, replace ManagerResolve with 
VPResolve. 

c.   Click the Apply button. The connector as a result is now VPResolve 
(Figure 4-13). 

 
Figure 4-12. Flow Action Update 

 
Figure 4-13. Connector Properties 

d.   Click Save to save your changes. 

e.   Click Return  to close the Flow Editor and return to the Flow rule 
form. 
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3. Test the revised process to verify that the VP is now required to enter an 
Approval Code and an optional note when approving a purchase order 
request following the steps below: 

a.   Select the Run > Process > Purchase Order 

b.   Create a purchase order request that requires VP approval. The 
requirements are stated in the decision rule table you created in Figure 
3-23. For example, enter HR as the Department Name and select one 
$2,500 laptop, which requires VP approval.  

c.   As manager, approve the request.  

d.   Click the VP Approval link. The VP sees the Take Action box shown in 
Figure 4-14. 

 
Figure 4-14. Take Action for VP 

When the VP clicks Approve, the approval screen appears. The VP is now 
required to enter an approval code and may also enter an optional note 
(Figure 4-15). 
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Figure 4-15. Approval Code  

Click the Expand button ( ) to enter a note. Enter the information and click 
Submit to finish the process. 



4-14   Developer Fast Start  

 
 

 

Adding a Data Field 
When approving purchase order requests, the Vice President would like to add a 
payment date. To support this requirement, add a Payment Date field to the Vice 
President Approval form. 

1. Log in as Developer@AlphaCorp.com with the password rules.  

2. In the Application Explorer, the flow action you created earlier (VPResolve) 
appears as part of the User Interface category. Click the VPResolve flow 
action link to open the rule (Figure 4-16 and Figure 4-17). 

 
Figure 4-16. VPResolve Flow Action  

 
Figure 4-17. Flow Action – Current Form  

3. Select the Approval Code cell and then click the Insert Row After button  
to insert a new row below the Approval Code row (Figure 4-18). 

mailto:DeveloperNN@AlphaCorp.com�


Developer Fast Start  4-15 

 
 

 

 
Figure 4-18. Flow Action – Inserting a Row  

4. A property rule named PaymentDate already exists. Add this property to 
the new row following the steps below:  

a.   Click the plus sign (in the Application Explorer) to expand the Property 
category  within the Purchase Order work type. 

b.   Click the plus sign to expand the Property rule type  (Figure 4-19). 
Each blue dot identifies a simple property rule, one that holds only a 
single value such as a date or amount. Other icons in this tree, such as 

, identify aggregate properties, which are similar to arrays and 
structures. 

c.   Select the blue dot to the left of the PaymentDate link. (Do not click the 
PaymentDate link.) 

 
Figure 4-19. Payment Date – Using an Existing Property  

5. Hold the mouse button down, and drag the property onto the Flow Action 
rule form (Figure 4-20). Drop the property into the right Field cell of the new 
row. 
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Figure 4-20. Payment Date Label  

The cell now contains the .PaymentDate property. This property holds a date 
and time. Process Commander supports a wide variety of input and output 
formats for dates and times. 

6. Click the Magnifying Glass icon  next to the Payment Date cell to open 
the Cell Properties panel and specify a display format for the PaymentDate 
property. 

7. Select the magnifying Glass icon next to the Display As field to open the 
Param Window (Figure 4-21).  
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Figure 4-21. Display As Selection  
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8. Complete the Display Formats dialog following these steps  

a.   Select DateTime for the Format field. (SmartPrompt is available.) 

b.   Click the Params button and select display parameters for the format. 
Select the Calendar Icon and Allow Text Field Entry check boxes. In 
the Available Formats section, select the format that you like (Figure 
4-22). 

Note: In this example the display mode is set to Popup window which 
displays the calendar in a separate popup window. Allow TextField 
Entry is set to enable text to be entered. Available Formats indicate the 
type of display to be used.  

 
Figure 4-22. Display Parameter 
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9. Click OK to save the display format to the rule form. The Format dialog 
closes. 

10. In the Cell Properties panel, click OK. 

11. Click the Save toolbar button  to save the updated VPResolve flow 
action rule form. 

12. Click the Preview toolbar button  to view the effect of your changes 
(Figure 4-23).   

 
Figure 4-23. Preview of Changes 

13. Test the changes, following the steps below:  

a.   Select Run > Process > PurchaseOrder to create a new purchase order 
request.  

b.   Choose order quantities that will require Vice President approval. 

c.   Enter shipping details and complete the manager approval step. 

d.   As Vice President, confirm that the payment date is requested.  

e.   Click the calendar icon  to enter a date and time. 
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Inspecting Declarative Rules 
This application calculates several properties with declarative rules, which are 
rules that define calculations among property values. For example, the 
OrderTotal property value is the sum of all LineItemTotal values, and each 
LineItemTotal is the value of the item’s Price multiplied by Quantity.  

To see the list of declarative rules, go to the Application Explorer, select the 
AlphaCorp-OrderEntrySystem class, expand Decision, and then expand the 
Declare Expressions category as shown in Figure 4-24. 

 
Figure 4-24. Declare Expressions in Application Explorer 

To open a rule, click on a rule name. Figure 4-25 and Figure 4-26 show the 
.OrderTotal and LineItemTotal.Order() rule forms respectively. The property 
values are enclosed in the dashed red lines. 
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Figure 4-25. Declarative Expression for Order Total  

 
Figure 4-26. Declarative Expression for Line Item Total 

Like formulas in a Microsoft Excel spreadsheet, properties controlled by 
declarative rules are computed automatically whenever a value changes that 
affects the computation. For example, the target property LineItemTotal is 
computed whenever the Price or Quantity changes. Similarly, you don’t need to 
create an explicit program to recalculate the OrderTotal after you input a quantity.  

Using the Declarative Rules Inspector 
You can use the Declarative Rules Inspector to see which properties are 
dependent upon these rules, and to graphically illustrate those dependencies.  

1. To enable the Declarative Rules Inspector, select Run > Rules Inspector 
> Declarative Rules (Figure 4-27). 

 
Figure 4-27. Declarative Rules Inspector 
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2. Create a new purchase order request by selecting Run > Process > 
Purchase Order menu item. On the work object form, a “D” link appears 
next to each property that is calculated by a declarative rule. For example, 
assume that you enter four order items and then advance to a form that 
includes Order Total. Notice that a D appears next to the property (Figure 
4-28). Click the “D” link to inspect how that property value is calculated. 

 
Figure 4-28. Reviewing Declarative Rules  

After clicking the “D”, the Dependency Network Viewer appears showing the 
Dependency Network for the OrderTotal property (Figure 4-29). 

 
Figure 4-29. Dependency Network Viewer  

The symbols shown are described below: 

■ A function symbol ( ) references a declarative rule. 

■ The arrows show how computations depend on each other; that is, where 
results from one computation feed into inputs of a later computation.  

Process Commander supports complex declarative rules and lets you test and 
debug declarative computations interactively.  

To disable the Rules Inspector feature, select Run > Rules Inspector > 
Declarative Rules. 
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Chapter 5:   
Reviewing Your Application 

By following Chapters 3 and 4 in this tutorial, you used rule forms and the flow 
editor to refine the Order Entry System application. Process Commander uses 
sophisticated industry-standard technologies to implement your changes without 
requiring you to directly specify coding-level details. You do not need advanced 
IT skills to produce applications that are functional, easy to use, and visually 
appealing. 

Developing Applications by Changing Rules  
You created a few rules in the OrderEntryDev RuleSet that include the following: 

■ A flow rule PurchaseOrder that supports the VP approval steps, replacing the 
less-sophisticated flow rule in the original application 

■ A decision table rule NeedsVPApproval that controls which purchase order 
requests are routed to the VP for review 

■ Two property rules used to hold values entered by the Vice President: 

 ApprovalCode  

 PaymentDate  

■ A VPResolve flow action that prompts the VP with two new fields after the VP 
approves a purchase order request 
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These rules supplement the rules in the OrderEntrySystem RuleSet, which 
defines the original application before you changed it. As you will see in Chapter 
6, Documenting Your Application, the Order Entry System RuleSet contains 
about 125 rules. 

The Application Explorer provides developers with quick access to rules in both 
the OrderEntrySystem RuleSet and the OrderEntryDev RuleSet. These rules, in 
turn, build on hundreds of built-in, out-of-the-box standard rules that are present 
in every Process Commander system and form the foundation building blocks of 
applications. 
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Technology Under the Covers  
If you are familiar with the technologies mentioned below, you can appreciate the 
power and breadth of Process Commander as a development environment. 

■ A property rule (for example the ApprovalCode property) corresponds to a 
scalar variable. 

■ Flow action rules are converted to HyperText Markup Language (HTML).  

■ The Visio representation of a business process is converted internally to an 
XML (eXtended Markup Language) document that later becomes a Java 
class. 

■ Rules and other data are stored in a relational database supported by any of 
several popular database products from Oracle, Microsoft or IBM. 

■ Computations such as declarative rules and decision table rules are 
transformed into efficient Java programs. 

The architecture and design of Process Commander provides these benefits: 

■ Inheritance and polymorphism that allows you to build applications by 
overriding or extending existing rules. For example, the flow rule that you 
created overrides (supersedes) the initial flow rule that came with the Order 
Entry System application. 

■ Through hardware clustering, one Process Commander system can support 
thousands of users in multiple locations who enter, work on, and resolve 
millions of work objects. 

■ Applications can be developed iteratively with incremental enhancements. 

■ Developers can quickly switch from a development task to a testing task and 
back as you did by using the Run > Process menu.  

■ Process Commander applications can interface with other systems using a 
wide variety of industry-standard technologies (such as SOAP / Web 
services, e-mail, relational databases, J2EE facilities including Enterprise 
JavaBeans, and JavaServer Pages).  
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Chapter 6:   
Documenting Your Application  

Process Commander includes tools that enable you to easily document what you 
have built. This chapter describes how to use those tools.  
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Documenting the Order Entry System Application  
1. Select Application > Document (Figure 6-1) 

 
Figure 6-1. Document Menu Item  
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A Document wizard appears, letting you select which items you would like to 
include about your application in the document (Figure 6-2). Complete the 
wizard selecting desired criteria.  

 
Figure 6-2. Document Selection Menu  
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2. Click the Create Document button. Process Commander creates a Word 
document listing all the rules in your application. This may take a minute or 
two (Figure 6-3). 

 
Figure 6-3. Create Document 

The following pages show the document created by Process Commander for the 
Order Entry System.  

Note:  Page breaks and fonts in the generated Order Entry System document 
have been modified for inclusion in this book. 

 

When your work with Process Commander is complete, click the Log Off link at 
the upper right corner of the Developer portal to end the Internet Explorer client 
session. 

This is the conclusion of the Developer Fast Start guide. More information on the 
OrderEntrySystem application and appendices on the Developer toolbar and 
Workstation Setup can be found in the following pages. 
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Application Document for OrderEntrySystem 

01.01.01 
OrderEntrySystem 

 
 

 

 

 

 

 

 

 

 

 

Created by: Developer  
On March 20, 2009 
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Overview of OrderEntrySystem 
01.01.01  

Description 
Created by External Setup Wizard  

Actors 
  
None found  

Work Types 
Name Implementation Class 

AlphaCorp-OrderEntrySystem AlphaCorp-OrderEntrySystem 

AlphaCorp-OrderEntrySystem-PurchaseOrder AlphaCorp-OrderEntrySystem-PurchaseOrder 

RuleSets 
RuleSet Version Description Prerequisites 

OrderEntrySystem 02-03-01 RuleSet to identify, manage, and control the set of rule 
instances that define OrderEntrySystem application 

AlphaCorp:01-01-01 
Pega-ProCom:05-05-05 
Pega-AppDefinition:05-05-05 

AlphaCorp 01-01-01 Template Pega-ProCom:05-05-05 
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AlphaCorp-OrderEntrySystem 
Implementation: AlphaCorp-OrderEntrySystem  
Description: Order Entry System 
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AlphaCorp-OrderEntrySystem-
PurchaseOrder 
Implementation: AlphaCorp-OrderEntrySystem-PurchaseOrder  
Description: Properties, HTML forms, and flows in the AlphaCorp-OrderEntrySystem-PurchaseOrder class are available to 
support the behavior and appearance of Purchase Order type of work 
   

PurchaseOrder - Flow 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Purchase Order 
Long Description: Basic Process Template of ProcessFlow (Default) Flow Category 
Usage: Basic Process Template of ProcessFlow (Default) Flow Category [Generated automatically through Accelerator process] 
RuleSet: OrderEntryDev : 01-01-01  
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Flow Diagram 

 

Primary Path 

Submit,90% - Transition 
Implementation: Submit 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Enter Order Items 
Long Description: Used to set the pyChargeAmount field. 
Usage: Used on StandardRequest flow. 
RuleSet: OrderEntrySystem : 02-03-01  



Developer Fast Start  37 

 
 

 

Resolve,100% - Transition 
Implementation: Resolve 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Confirm this order 
Long Description: Use this FlowAction to Record Completion of Work. 
RuleSet: OrderEntrySystem : 02-03-01  

NeedsApproval - Decision 
Implementation: OrderTotalNeedsApproval 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: AlphaCorp-OrderEntrySystem 
Short Description: OrderTotalNeedsApproval 
RuleSet: OrderEntrySystem : 02-03-01  
 
• if .OrderTotal > 100 then RETURN True  
otherwise RETURN False  

Alternate Path 1 

ManagerResolve,80% - Transition 
Implementation: ManagerResolve 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Approve 
Long Description: Use this FlowAction to Record Completion of Work. 
RuleSet: OrderEntrySystem : 02-03-01  

NeedsVPApproval - Decision 
Implementation: NeedsVPApproval 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: NeedsVPApproval 
RuleSet: OrderEntryDev : 01-01-01  

 Conditions   Actions  

  DeptName  BillCustomer  OrderTotal   Return 

  =  =  =    

if  IT  >1000  True 

else if  HR  >500  True 

else if  Finance =False   True 

else if  Finance =True >200  True 

else if  Legal =True >500  True 

else if  Legal =False >200  True 

Otherwise     False 

VPResolve,75% - Transition 
Implementation: VPResolve 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
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Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Approve 
Long Description: Use this FlowAction to Record Completion of Work. 
RuleSet: OrderEntryDev : 01-01-01  

Alternate Path 2 

Reject,25% - Transition 
Implementation: Reject 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Reject 
Long Description: This flow action is for rejecting the work object. 
Usage: Used by the StandardEvaluate flow. Approval flows should use the Disapprove flow action, not Reject. 
RuleSet: OrderEntrySystem : 02-03-01  

Alternate Path 3 

Reject,20% - Transition 
Implementation: Reject 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
 
See Reject (Page 38) 

Alternate Path 4 

Reject,10% - Transition 
Implementation: Reject 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
 
See Reject (Page 38) 

Other Referenced Rules 

Save - Flow Action 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Save 
Long Description: Save - The validate activity will not be called 
RuleSet: OrderEntrySystem : 02-03-01  

Transfer - Flow Action 
Referenced By: PurchaseOrder - Flow (Page 6-35) 
Applies to Class: Work- 
Short Description: ReAssign 
Long Description: ReAssign the Assignment (LocalAction) 
RuleSet: Pega-ProCom : 05-05-01  
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PurchaseOrder - Flow 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: Purchase Order 
Long Description: Basic Process Template of ProcessFlow (Default) Flow Category 
Usage: Basic Process Template of ProcessFlow (Default) Flow Category [Generated automatically through Accelerator process ] 
RuleSet:  OrderEntrySystem : 02-03-01  
 
Flow Diagram 

 

Primary Path 

Submit,90% - Transition 
Implementation: Submit 
Referenced By: PurchaseOrder - Flow (Page 39) 
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See Submit (Page 36) 

Resolve,100% - Transition 
Implementation: Resolve 
Referenced By: PurchaseOrder - Flow (Page 39) 
 
See Resolve (Page 37) 

NeedsApproval - Decision 
Implementation: OrderTotalNeedsApproval 
Referenced By: PurchaseOrder - Flow (Page 39) 
 
See OrderTotalNeedsApproval (Page 37) 

Alternate Path 1 

ManagerResolve,80% - Transition 
Implementation: ManagerResolve 
Referenced By: PurchaseOrder - Flow (Page 39) 
 
See ManagerResolve (Page 37) 

Alternate Path 2 

Reject,20% - Transition 
Implementation: Reject 
Referenced By: PurchaseOrder - Flow (Page 39) 
 
See Reject (Page 38) 

Alternate Path 3 

Reject,10% - Transition 
Implementation: Reject 
Referenced By: PurchaseOrder - Flow (Page 39) 
 
See Reject (Page 38) 
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Decisions 

Tables 

PriceLookup 
Applies to Class: AlphaCorp-OrderData 
Short Description: PriceLookup 
RuleSet:  OrderEntrySystem : 02-03-01  

 Conditions   Actions  

  ItemName   Return 

  =    

if  Laptop  "2500.00" 

else if  Keyboard  "39.99" 

else if  Monitor  "550.00" 

else if  Mouse  "19.99" 

else if  Printer  "325.50" 

else if  Pen  "1.00" 

else if  Stapler  "5.59" 

else if  Envelopes  "2.50" 

Otherwise    

NeedsVPApproval 
Applies to Class: AlphaCorp-OrderEntrySystem-PurchaseOrder 
Short Description: NeedsVPApproval 
RuleSet:  OrderEntryDev : 01-01-01  

 Conditions   Actions  

  DeptName  BillCustomer  OrderTotal   Return 

  =  =  =    

if  IT  >1000  True 

else if  HR  >500  True 

else if  Finance =False   True 

else if  Finance =True >200  True 

else if  Legal =True >500  True 
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 Conditions   Actions  

else if  Legal =False >200  True 

Otherwise     False 

Trees 

OrderTotalNeedsApproval 
Applies to Class: AlphaCorp-OrderEntrySystem 
Short Description: OrderTotalNeedsApproval 
RuleSet:  OrderEntrySystem : 02-03-01  
 
• if .OrderTotal > 100 then RETURN True  
otherwise RETURN False  

Map Values 
None found  
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Activities 
Applies To Name Description RuleSet Version 

Purchase Order  Add Delivery Add Delivery Order Entry System 02-03-01  

Purchase Order  First Order First Order Order Entry System 02-03-01  

Purchase Order  To Manager To Manager Order Entry System 02-03-01  

Purchase Order  To VP To VP Order Entry System 02-03-01  

Document an Application  Open Application Open Application Order Entry System 02-03-01  
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Properties 
Applies To Name Description Mode RuleSet Version 

Alpha Corp- Order Data Item Name Item Name String  Order Entry System 02-03-01  

Alpha Corp- Order Data Line Item Total Line Item Total String  Order Entry System 02-03-01  

Alpha Corp- Order Data Price Price String  Order Entry System 02-03-01  

Alpha Corp- Order Data Quantity Quantity String  Order Entry System 02-03-01  

Alpha Corp- Order 

Delivery Info 
Delivery Method Delivery Method String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System 
Bill Customer Bill Customer String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System 
Dept Name Dept Name String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System 
Dept Number Dept Number String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System 
Order Order PageList  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System 
Order Date Order Date String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System 
Order Total Order Total String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
Address Address String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
Address2 Address String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
Approval Code Approval Code String  Order Entry Dev 01-01-01  

Alpha Corp- Order Entry 

System- Purchase Order 
City OE City OE String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
Delivery List Delivery List PageList  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
Multiple Del Multiple Del String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
Payment Date Payment Date String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
State OE State OE String  Order Entry System 02-03-01  

Alpha Corp- Order Entry 

System- Purchase Order 
Zipoe zipoe String  Order Entry System 02-03-01  

Alpha Products Product Name Product Name String  Order Entry System 02-03-01  

Alpha Products Product Price Product Price String  Order Entry System 02-03-01  
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Applies To Name Description Mode RuleSet Version 

Work- py Selected Selection Flag String  Order Entry System 02-03-01  
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Declaratives 

Expressions 

.LineItemTotal .Order() 
Applies to Class: AlphaCorp-OrderEntrySystem 
Short Description: .LineItemTotal 
RuleSet:  OrderEntrySystem : 02-03-01  
 
Execute this expression: Only when the top-level page is of the Applies To class 
 
Calculate value: Whenever inputs change 
 
Set .LineItemTotal = Value of .Price * .Quantity 

.OrderTotal  
Applies to Class: AlphaCorp-OrderEntrySystem 
Short Description: .OrderTotal 
RuleSet:  OrderEntrySystem : 02-03-01  
 
Execute this expression:  
 
Calculate value: Whenever inputs change 
 
Set .OrderTotal =  

.Price .Order() 
Applies to Class: AlphaCorp-OrderEntrySystem 
Short Description: .Price 
RuleSet:  OrderEntrySystem : 02-03-01  
 
Execute this expression: Only when the top-level page is of the Applies To class 
 
Calculate value: Whenever inputs change 
 
Set .Price = Result of Decision Table PriceLookup 

Triggers 
None found  

OnChange 
None found  
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Appendix A 
The Developer Toolbar   

A toolbar appears at the top of the Developer portal. The buttons that appear on 
the toolbar depend on the class or instance selected.  

Toolbar Buttons and Functions 
The tools and selection boxes on the toolbar vary depending on the contents of 
the form and list area. If a button does not appear or is unavailable (gray), the 
corresponding function is not available to you in the current context.  

Figure A-0-1 describes all the buttons that may appear.  

Name Button Function 

Availability 
 

Changes the availability of the rule. Select Yes, No/Draft Mode, Final, or 
Blocked from the dialog box that opens.  

Check In 
 

This button appears only for rules in RuleSets subject to rule 
management. After checking out a rule to a private RuleSet, use Check In 
to copy the modified rule over the original in the public RuleSet.  

Check Out 
 

This button appears only for rules in RuleSets subject to rule 
management. Creates a copy of a rule in your private RuleSet and marks 
the original rule as checked out. No one else can check out a rule while it 
is checked out.  

Delete 
 

Deletes a rule or data instance.  
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Name Button Function 

Delete Check-out 
 

Delete a checked-out rule from your personal RuleSet.  

Draft Mode 
 

Click to turn draft mode on or off. Elements of this flow rule may reference 
activities, flow actions, or other objects as yet undefined.  

Favorites 
 

Adds to your Favorites in Internet Explorer, or helps you delegate a rule 
using the My Rules feature.  

Flow Editor 
 

Starts Visio for you to edit or review the flow.  

Help 
 

Opens the Help window for the currently displayed rule or data form.  

Launch 
 

Moves the current form into a separate window with a copy of its own 
toolbar, enabling you to compare two forms, or work with a source of 
information or values in the main portal window and paste into another 
portal window.  

Navigate Left 
 

Scrolls the toolbar to the left if the toolbar is wider than the browser 
window. 

Navigate Right 
 

Scrolls the toolbar to the right if the toolbar is wider than the browser 
window. 

New 
 

Creates a new rule or data instance of the same type as the currently open 
rule or data instance. Use the arrow to display a menu containing all rule 
types. 

Next View  
 

Cycles down to the next item in the Views display — open forms, most 
recent list, home slices, and wizards.  

Preview 
 

Splits the workspace to present a partial preview of the runtime 
appearance of a rule in the bottom half.  

Previous Rule 
 

Cycles up to the next item in the Views display — open forms, most recent 
list, home slices, and wizards.  

Print 
 

Prints all tabs of the topmost form.  

Recover 
 

Recovers the most recent version of a deleted rule, if the RuleSet and 
version is unlocked.  

Refresh 
 

Refreshes the browser display from the latest data in the Process 
Commander server, ensuring that the display has the most current data. 
Any inputs you have entered but not sent are lost.   

Related Rules  Lists rules related to the current rule. Clicking displays a menu that lists 
lower-numbered versions of the currently open rule, circumstance and 
circumstance-date, editions, and additional menu items.  
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Name Button Function 

Restore 
 

Replaces the current checked-in copy of a rule with the last checked-in 
copy of that rule.  

Return  
 

Exits Visio and returns to normal editing mode.  

Rule Data 
 

Shows the XML document that makes up the form displaying this instance. 
This is primarily a debugging tool.  

Run 
 

Starts execution or testing of the current rule, in the current context.  

Save 
 

Saves the instance to the PegaRULES database. 

Save As 
 

Saves the instance under a different name, RuleSet, or version.  

Show Java 
 

After a rule is saved, approximation of the generated Java to be created by 
this rule instance appears in a new window. (You cannot alter this Java 
code.) This button is visible to developers who hold the privilege 
@baseclass.ToolbarFull. Available for activities, when rules, and stream 
rules, among others. 

Views 
 

Click to access a pop-up window listing currently open forms by type, the 
most recent list presented in the portal workspace, and wizards in process. 

Visio Tools  Display, or hide, Visio toolbars during Visio editing. 

Zoom In (Visio) 
 

Zoom in on the Visio diagram, to make the diagram larger. 

Zoom Out (Visio) 
 

Zoom out from the Visio diagram, to make the diagram smaller. 

Figure A-0-1. Workspace Toolbar Buttons 
 





 

 

 

Appendix B 
Workstation Setup   

This Appendix describes setting up your Process Commander workstation and 
includes information about: 

■ Temporary internet file settings 

■ Downloaded program files 

■ Other security settings 

■ Performance tips and keyboard shortcuts 

■ Visio settings 
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Internet Explorer Settings 
Process Commander works with Microsoft Internet Explorer Web browser 
version 6.01 or version 7 with current Microsoft security patches installed. To use 
the Developer portal you must use Internet Explorer 6 and 7 only, but the V5.5 
composite portals (User and Manager, not WorkUser and WorkManager) also 
support Firefox 2+. Internet Explorer is also known as IE or MSIE, and serves as 
a thin client for both application developers and application users. All pop-up 
blockers (such as those provided by Yahoo! or Google toolbars) must be 
disabled.  

Several settings are important for best use of MSIE with Process Commander. In 
many cases, these may correspond to the settings you normally use for intranet 
or other Local Zone processing. 

For additional settings not needed by most Developer Fast Start readers, select 
Help > Developer Help to open the Process Commander help system, and 
search for the topic “How to set up Internet Explorer. “ 

Temporary Internet Files Settings 
Process Commander uses HTTP 1.1 and marks pages as expired as 
appropriate. To set this property in Internet Explorer version 6.0 SP1, navigate to 
Tools > Internet Options > General > Temporary Internet Files > Settings, and 
select Automatic. In Internet Explorer version 7, navigate to Tools > Internet 
Options > General and click the Settings button under Browsing history. Select 
Automatically in the Temporary Internet Files options. 

The system responds best if your MSIE cache is enabled, because the cache 
can store images and other static files locally. However, caching is not required. 

Downloaded Program Files 
Process Commander uses a few ActiveX controls on the workstation. Each 
automatically downloads on demand (only as needed) if permitted by your 
Windows network account and Internet Explorer settings.  

If your Windows account has Power User or Administrator privileges, you can 
download these controls. If not, another user with appropriate privileges can 
download them for you, by signing on and using Process Commander briefly. 
(You do not need Power User or Administrator privileges to run the ActiveX 
controls.) 

Select Tools > Internet Options > Security > Local Zone to confirm that you can 
download signed ActiveX controls. You can set security for the Local Zone to 
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Low, or can choose Custom and turn on the download settings  
(Figure B-1 and Figure B-2): 

 
Figure B-1.   Download Enabled 

  
Figure B-2. ActiveX Downloads Enabled 

Other Security Settings 
Typically, the Process Commander server operates on a local area network 
(LAN) and appears in the Local Zone of Internet Explorer. You can adjust 
security settings for the Local Zone without affecting the security settings you 
want to apply for the Internet.  

■ Cookies — Process Commander uses cookies. Internet Explorer settings 
must permit cookies.  

■ Pop-up windows — Certain portal operations use pop-up windows. Pop-up 
blockers (such as the Google toolbar) may interfere with correct operation of 
these windows.  

■ Scripting — Process Commander uses JavaScript. Applications based on 
Process Commander may use VBScript or JScript in addition to JavaScript. 
Users must have the ability to execute scripts in the Local Zone. This is 
available under the Low setting for the Local Zone or as a custom setting. 

 

■ Windows XP SP2 restrictions on file downloads — If your workstation 
operating system is Windows XP SP2 and your Process Commander server 
is identified (in the URL on the Internet Explorer Address line) by an IP 
address or by a domain-qualified name (such as myserver.mydomain.sub), 
an Internet Explorer setting may restrict your ability to use file attachments. 
Open the Custom Levels dialog by selecting Tools > Internet Options panel 
for the Local Internet zone. Clear the Automatic Prompting for File 
Download setting.   
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Performance Tips and Keyboard Shortcuts 
Developers and users are most productive if they remember these tips: 

■ Click the logo on the upper left of the portal to return to your portal home 
view. 

■ Don't use the Internet Explorer Back button or the Back keyboard shortcut. 
Don't use the Internet Explorer History capabilities to return to an earlier 
page. The older pages may contain stale information, and the Back and 
History features may interfere with session synchronization.  

■ Click the Refresh button  on the Process Commander toolbar, not the 
Internet Explorer refresh button  or the F5 key, to refresh the current 
display. 

■ Press CTRL+F to search for text on a page. 

■ Press CTRL+P to print the current page. 
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Visio Settings 
Process Commander uses an ActiveX to control support flows in Microsoft Visio. 
Follow these steps to set up Microsoft Visio 2002 or 2003 to work with Process 
Commander flows: 

1. Add Pegasystems as a trusted source of Visio XP macros. 

You may receive the following warning when first opening a flow  
(Figure B-3). 

 
Figure B-3. Visio Macro Security Warning 

2. Select Always trust macros from this source. This adds Pegasystems 
Inc. to the Trusted Sources list. Pegasystems Inc. has digitally signed the 
Visio XP macros with a Code Signing (level 3) Digital ID Certificate from 
VeriSign. 

3. The Enable Macros button becomes available. Click the Enable Macros 
button to start a successful Visio flow editing session. This dialog will not 
appear again. 
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4. Alternatively, set macro security to Medium or Low 

The Visio Flow Editors in Process Commander use VBA (Visual Basic for 
Applications) macros. Visio offers four levels of macro security that you 
control through the dialog setting. If you only edit flow rules created with Visio 
and have accepted Pegasystems Inc as a trusted source, you can leave the 
setting at High. Otherwise, use Medium or Low.  

 Start Visio. Select the Tools> Macros> Security menu item in Visio to 
access the Security dialog (Figure B-4).  

 Set the Visio Macro security level to Medium (for prompting) or Low (for 
no prompting). Click OK  

 
Figure B-4. Visio Macro Security Levels 

For more information on Visio security issues, search for the topic How to Set Up 
Visio in the Process Commander Application Developer help system. 
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